

    
      
          
            
  
SunFounder ESP32 Starter Kit

Thanks for choosing our ESP32 Starter Kit.


Note

This document is available in the following languages.



	Lecciones en línea de español


	Deutsch Online-Kurs


	日本語オンライン教材


	English Online-tutorials







Please click on the respective links to access the document in your preferred language.
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Welcome to the ESP32 Learning Kit! This comprehensive package is designed to offer both beginners and seasoned developers a deep dive into the versatile world of the ESP32 microcontroller. With the ESP32 WROOM 32E at its core, and a range of accompanying components like LEDs, sensors, motors, and more, users can explore a vast array of projects.

Whether you’re keen on basic electronics, IoT integrations, this kit has it all. For MicroPython enthusiasts, we provide a structured introduction to MicroPython, complete with IDE setups and basic syntax lessons. Arduino users are not left behind, with a dedicated section on getting started with Arduino, and a suite of basic projects to jumpstart the learning process.

For the creatives, there’s a delightful section on integrating with Scratch, allowing for a blend of programming and storytelling. Each project in the kit is meticulously outlined, ensuring you understand the objectives, the circuit assembly, and the programming aspects.

With a myriad of game projects, practical applications, and troubleshooting FAQs, this kit promises an enriching learning experience for all. Dive in and let the ESP32 adventure begin!

If you have any questions or other interesting ideas, feel free to send an email to service@sunfounder.com.
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Download the Code

Here is the complete code package for the ESP32 Starter Kit. You can click on the following link to download it:


	SunFounder ESP32 Starter Kit [https://github.com/sunfounder/esp32-starter-kit/archive/refs/heads/main.zip]




Once the download is complete, unzip the file and open the relevant example code or project files in the corresponding software. This will allow you to browse and utilize all the code and resources provided by the kit.




            

          

      

      

    

  

    
      
          
            
  
For Arduino User

Here is the complete code package for the ESP32 Starter Kit. You can click on the following link to download it:


	SunFounder ESP32 Starter Kit [https://github.com/sunfounder/esp32-starter-kit/archive/refs/heads/main.zip]




Once the download is complete, unzip the file and open the relevant example code or project files in the corresponding software. This will allow you to browse and utilize all the code and resources provided by the kit.

1. Get Started



	1.1 Install Arduino IDE(Important)

	1.2 Introduce of Arduino IDE

	1.3 Install the ESP32 Board(Important)

	1.4 Install libraries (Important)





2. Displays



	2.1 Hello, LED!

	2.2 Fading

	2.3 Colorful Light

	2.4 Microchip - 74HC595

	2.5 7 Segment Display

	2.6 Display Characters

	2.7 RGB LED Strip





3. Sounds



	3.1 Beep

	3.2 Custom Tone





4. Actuators



	4.1 Motor

	4.2 Pumping

	4.3 Swinging Servo





5. Sensors



	5.1 Reading Button Value

	5.2 Tilt It！

	5.3 Detect the Obstacle

	5.4 Detect the Line

	5.5 Detect Human Movement

	5.6 Two Kinds of Transistors

	5.7 Feel the Light

	5.8 Turn the Knob

	5.9 Measure Soil Moisture

	5.10 Thermometer

	5.11 Toggle the Joystick

	5.12 Measuring Distance

	5.13 Temperature - Humidity

	5.14 IR Receiver





6. Funny Projects



	6.1 Fruit Piano

	6.2 Flowing Light

	6.3 Reversing Aid

	6.4 Digital Dice

	6.5 Color Gradient

	6.6 Plant Monitor

	6.7 Guess Number





7. Bluetooth&SD Card&Camera&Speaker



	7.1 Bluetooth

	7.2 Bluetooth Control RGB LED

	7.3 Bluetooth Audio Player

	7.4 SD Card Write and Read

	7.5 MP3 Player with SD Card Support

	7.6 Take Photo SD





8. Bluetooth&SD Card&Camera&Speaker



	8.1 Real-time Weather From @OpenWeatherMap

	8.2 Camera Web Server

	8.3 Custom Video Streaming Web Server

	8.4 IoT Communication with MQTT

	8.5 CheerLights

	8.6 Temperature and Humidity Monitoring with Adafruit IO

	8.7 ESP Camera with Telegram Bot

	8.8 Camera with Home Assistant

	8.9 Blynk-based Intrusion Notification System

	8.10 Android Application - RGB LED Operation via Arduino and Bluetooth








            

          

      

      

    

  

    
      
          
            
  
1.1 Install Arduino IDE(Important)

The Arduino IDE, known as Arduino Integrated Development Environment, provides all the software support needed to complete an Arduino project. It is a programming software specifically designed for Arduino, provided by the Arduino team, that allows us to write programs and upload them to the Arduino board.

The Arduino IDE 2.0 is an open-source project. It is a big step from its sturdy predecessor, Arduino IDE 1.x, and comes with revamped UI, improved board & library manager, debugger, autocomplete feature and much more.

In this tutorial, we will show how to download and install the Arduino IDE 2.0 on your Windows, Mac, or Linux computer.


Requirements


	Windows - Win 10 and newer, 64 bits


	Linux - 64 bits


	Mac OS X - Version 10.14: “Mojave” or newer, 64 bits






Download the Arduino IDE 2.0


	Vist Arduino IDE 2.0.0 Page.


	Download the IDE for your OS version.


[image: ../../_images/sp_001.png]









Installation


Windows


	Double click the arduino-ide_xxxx.exe file to run the downloaded file.


	Read the License Agreement and agree it.


[image: ../../_images/sp_002.png]





	Choose installation options.


[image: ../../_images/sp_003.png]





	Choose install location. It is recommended that the software be installed on a drive other than the system drive.


[image: ../../_images/sp_004.png]





	Then Finish.


[image: ../../_images/sp_005.png]









macOS

Double click on the downloaded arduino_ide_xxxx.dmg file and follow the instructions to copy the Arduino IDE.app to the Applications folder, you will see the Arduino IDE installed successfully after a few seconds.

[image: ../../_images/macos_install_ide.png]


Linux

For the tutorial on installing the Arduino IDE 2.0 on a Linux system, please refer to: https://docs.arduino.cc/software/ide-v2/tutorials/getting-started/ide-v2-downloading-and-installing#linux




Open the IDE


	When you first open Arduino IDE 2.0, it automatically installs the Arduino AVR Boards, built-in libraries, and other required files.


[image: ../../_images/sp_901.png]





	In addition, your firewall or security center may pop up a few times asking you if you want to install some device driver. Please install all of them.


[image: ../../_images/sp_104.png]





	Now your Arduino IDE is ready!



Note

In the event that some installations didn’t work due to network issues or other reasons, you can reopen the Arduino IDE and it will finish the rest of the installation. The Output window will not automatically open after all installations are complete unless you click Verify or Upload.














            

          

      

      

    

  

    
      
          
            
  
1.2 Introduce of Arduino IDE

[image: ../../_images/sp_ide_2.png]

	Verify: Compile your code. Any syntax problem will be prompted with errors.


	Upload: Upload the code to your board. When you click the button, the RX and TX LEDs on the board will flicker fast and won’t stop until the upload is done.


	Debug: For line-by-line error checking.


	Select Board: Quick setup board and port.


	Serial Plotter: Check the change of reading value.


	Serial Monitor: Click the button and a window will appear. It receives the data sent from your control board. It is very useful for debugging.


	File: Click the menu and a drop-down list will appear, including file creating, opening, saving, closing, some parameter configuring, etc.


	Edit: Click the menu. On the drop-down list, there are some editing operations like Cut, Copy, Paste, Find, and so on, with their corresponding shortcuts.


	Sketch: Includes operations like Verify, Upload, Add files, etc. More important function is Include Library - where you can add libraries.


	Tool: Includes some tools - the most frequently used Board (the board you use) and Port (the port your board is at). Every time you want to upload the code, you need to select or check them.


	Help: If you’re a beginner, you may check the options under the menu and get the help you need, including operations in IDE, introduction information, troubleshooting, code explanation, etc.


	Output Bar: Switch the output tab here.


	Output Window: Print information.


	Board and Port: Here you can preview the board and port selected for code upload. You can select them again by Tools -> Board / Port if any is incorrect.


	The editing area of the IDE. You can write code here.


	Sketchbook: For managing sketch files.


	Board Manager: For managing board driver.


	Library Manager: For managing your library files.


	Debug: Help debugging code.


	Search: Search the codes from your sketches.







            

          

      

      

    

  

    
      
          
            
  
1.3 Install the ESP32 Board(Important)

To program the ESP32 microcontroller, we need to install the ESP32 board package in the Arduino IDE. Follow the step-by-step guide below:

Install the ESP32 Board


	Open the Arduino IDE. Go to File and select Preferences from the drop-down menu.


[image: ../../_images/install_esp321.png]





	In the Preferences window, locate the Additional Board Manager URLs field. Click on it to activate the text box.


[image: ../../_images/install_esp322.png]





	Add the following URL to the Additional Board Manager URLs field: https://espressif.github.io/arduino-esp32/package_esp32_index.json. This URL points to the package index file for the ESP32 boards. Click the OK button to save the changes.


[image: ../../_images/install_esp323.png]





	In the Boards Manager window, type ESP32 in the search bar. Click the Install button to start the installation process. This will download and install the ESP32 board package.


[image: ../../_images/install_esp324.png]





	Congratulations! You have successfully installed the ESP32 board package in the Arduino IDE.




Upload the Code


	Now, connect the ESP32 WROOM 32E to your computer using a Micro USB cable.


[image: ../../_images/plugin_esp32.png]





	Then select the correct board, ESP32 Dev Module, by clicking on Tools -> Board -> esp32.


[image: ../../_images/install_esp325.png]





	If your ESP32 is connected to the computer, you can choose the correct port by clicking on Tools -> Port.


[image: ../../_images/install_esp326.png]





	Additionally, Arduino 2.0 introduced a new way to quickly select the board and port. For ESP32, it is usually not automatically recognized, so you need to click on Select other board and port.


[image: ../../_images/install_esp327.png]





	In the search box, type ESP32 Dev Module and select it when it appears. Then, choose the correct port and click OK.


[image: ../../_images/install_esp328.png]





	Afterward, you can select it through this quick access window. Note that during subsequent use, there may be times when ESP32 is not available in the quick access window, and you will need to repeat the above two steps.


[image: ../../_images/install_esp329.png]





	Both methods allow you to select the correct board and port, so choose the one that suits you best. Now, everything is ready to upload the code to the ESP32.







            

          

      

      

    

  

    
      
          
            
  
1.4 Install libraries (Important)

A library is a collection of pre-written code or functions that extend the capabilities of the Arduino IDE. Libraries provide ready-to-use code for various functionalities, allowing you to save time and effort in coding complex features.

There are two main ways to install libraries:


Install from Library Manager

Many libraries are available directly through the Arduino Library Manager. You can access the Library Manager by following these steps:


	In the Library Manager, you can search for the desired library by name or browse through different categories.


Note

In projects where library installation is required, there will be prompts indicating which libraries to install. Follow the instructions provided, such as “The DHT sensor library library is used here, you can install it from the Library Manager.” Simply install the recommended libraries as prompted.



[image: ../../_images/install_lib3.png]


	Once you find the library you want to install, click on it and then click the Install button.

[image: ../../_images/install_lib2.png]


	The Arduino IDE will automatically download and install the library for you.






Manual Installation

Some libraries are not available through the Library Manager and need to be manually installed. To install these libraries, follow these steps:


	Open the Arduino IDE and go to Sketch -> Include Library -> Add .ZIP Library.

[image: ../../_images/a2dp_add_zip.png]


	Navigate to the directory where the library files are located, such as the esp32-starter-kit\c\libraries folder, and select the desired library file, like ESP32-A2DP.zip. Then, click Open.

[image: ../../_images/a2dp_choose.png]


	After a short while, you will receive a notification indicating a successful installation.

[image: ../../_images/a2dp_success.png]


	Repeat the same process to add the ESP8266Audio.zip library.





Note

The libraries installed using either of the above methods can be found in the default library directory of the Arduino IDE, which is usually located at C:\Users\xxx\Documents\Arduino\libraries.

If your library directory is different, you can check it by going to File -> Preferences.


[image: ../../_images/install_lib1.png]









            

          

      

      

    

  

    
      
          
            
  
2.1 Hello, LED!

Just as printing “Hello, world!” is the first step in learning to program, using a program to drive an LED is the traditional introduction to learning physical programming.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	LED

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_2.1_led.png]
This circuit works on a simple principle, and the current direction is shown in the figure. The LED will light up after the 220ohm current limiting resistor when pin26 outputs high level. The LED will turn off when pin26 outputs low level.

Wiring

[image: ../../_images/2.1_hello_led_bb.png]
Upload Code


	You can open the file 2.1_hello_led.ino under the path of esp32-starter-kit-main\c\codes\2.1_hello_led. Or copy this code to the Arduino IDE directly .



  
    
    

    2.2 Fading
    

    

    
 
  

    
      
          
            
  
2.2 Fading

In the previous project, we controlled the LED by turning it on and off using digital output. In this project, we will create a breathing effect on the LED by utilizing Pulse Width Modulation (PWM). PWM is a technique that allows us to control the brightness of an LED or the speed of a motor by varying the duty cycle of a square wave signal.

With PWM, instead of simply turning the LED on or off, we will be adjusting the amount of time the LED is on versus the amount of time it is off within each cycle. By rapidly switching the LED on and off at varying intervals, we can create the illusion of the LED gradually brightening and dimming, simulating a breathing effect.

By using the PWM capabilities of the ESP32 WROOM 32E, we can achieve smooth and precise control over the LED’s brightness. This breathing effect adds a dynamic and visually appealing element to your projects, creating an eye-catching display or ambiance.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	LED

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_2.1_led.png]
This project is the same circuit as the first project 2.1 Hello, LED!, but the signal type is different. The first project is to output digital high and low levels (0&1) directly from pin26 to make the LED light up or turn off, this project is to output PWM signal from pin26 to control the brightness of the LED.

Wiring

[image: ../../_images/2.1_hello_led_bb.png]
Code


Note


	You can open the file 2.2_fading_led.ino under the path of esp32-starter-kit-main\c\codes\2.2_fading_led.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?







  
    
    

    2.3 Colorful Light
    

    

    
 
  

    
      
          
            
  
2.3 Colorful Light

In this project, we will delve into the fascinating world of additive color mixing using an RGB LED.

RGB LED combines three primary colors, namely Red, Green, and Blue, into a single package. These three LEDs share a common cathode pin, while each anode pin controls the intensity of the corresponding color.

By varying the electrical signal intensity applied to each anode, we can create a wide range of colors. For example, mixing high-intensity red and green light will result in yellow light, while combining blue and green light will produce cyan.

Through this project, we will explore the principles of additive color mixing and unleash our creativity by manipulating the RGB LED to display captivating and vibrant colors.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	RGB LED

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_2.3_rgb.png]
The PWM pins pin27, pin26 and pin25 control the Red, Green and Blue pins of the RGB LED respectively, and connect the common cathode pin to GND. This allows the RGB LED to display a specific color by superimposing light on these pins with different PWM values.

Wiring

[image: ../../_images/rgb_pin.jpg]
The RGB LED has 4 pins: the long pin is the common cathode pin, which is usually connected to GND; the left pin next to the longest pin is Red; and the two pins on the right are Green and Blue.

[image: ../../_images/2.3_color_light_bb.png]
Code

Here, we can choose our favorite color in drawing software (such as paint) and display it with RGB LED.


Note


	You can open the file 2.3_rgb_led.ino under the path of esp32-starter-kit-main\c\codes\2.3_rgb_led.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?







  
    
    

    2.4 Microchip - 74HC595
    

    

    
 
  

    
      
          
            
  
2.4 Microchip - 74HC595

Welcome to this exciting project! In this project, we will be using the 74HC595 chip to control a flowing display of 8 LEDs.

Imagine triggering this project and witnessing a mesmerizing flow of light, as if a sparkling rainbow is jumping between the 8 LEDs. Each LED will light up one by one and quickly fade away, while the next LED continues to shine, creating a gorgeous and dynamic effect.

By cleverly utilizing the 74HC595 chip, we can control the on and off states of multiple LEDs to achieve the flowing effect. This chip has multiple output pins that can be connected in series to control the sequence of LED illumination. Moreover, thanks to the chip’s expandability, we can easily add more LEDs to the flowing display, creating even more spectacular effects.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	LED

	BUY



	74HC595

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_2.4_74hc595_led.png]

	When MR (pin10) is high level and CE (pin13) is low level, data is input in the rising edge of SHcp and goes to the memory register through the rising edge of SHcp.


	If the two clocks are connected together, the shift register is always one pulse earlier than the memory register.


	There is a serial shift input pin (DS), a serial output pin (Q7’) and an asynchronous reset button (low level) in the memory register.


	The memory register outputs a Bus with a parallel 8-bit and in three states.


	When OE is enabled (low level), the data in memory register is output to the bus(Q0 ~ Q7).




Wiring

[image: ../../_images/2.4_74hc595_bb.png]
Code


Note


	Open the 2.4_74hc595.ino file under the path of esp32-starter-kit-main\c\codes\2.4_74hc595.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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2.5 7 Segment Display

Welcome to this fascinating project! In this project, we will explore the enchanting world of displaying numbers from 0 to 9 on a seven-segment display.

Imagine triggering this project and witnessing a small, compact display glowing brightly with each number from 0 to 9. It’s like having a miniature screen that showcases the digits in a captivating way. By controlling the signal pins, you can effortlessly change the displayed number and create various engaging effects.

Through simple circuit connections and programming, you will learn how to interact with the seven-segment display and bring your desired numbers to life. Whether it’s a counter, a clock, or any other intriguing application, the seven-segment display will be your reliable companion, adding a touch of brilliance to your projects.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	7-segment Display

	BUY



	74HC595

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_2.5_74hc595_7_segment.png]
Here the wiring principle is basically the same as 2.4 Microchip - 74HC595, the only difference is that Q0-Q7 are connected to the a ~ g pins of the 7 Segment Display.


Wiring





	74HC595

	LED Segment Display





	Q0

	a



	Q1

	b



	Q2

	c



	Q3

	d



	Q4

	e



	Q5

	f



	Q6

	g



	Q7

	dp






Wiring

[image: ../../_images/2.5_segment_bb.png]
Code


Note


	Open the 2.5_7segment.ino file under the path of esp32-starter-kit-main\c\codes\2.5_7segment.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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2.6 Display Characters

Now, we will explore the fascinating world of character display using the I2C LCD1602 module.

Through this project, we will learn how to initialize the LCD module, set the desired display parameters, and send character data to be displayed on the screen. We can showcase custom messages, display sensor readings, or create interactive menus. The possibilities are endless!

By mastering the art of character display on the I2C LCD1602, we will unlock new avenues for communication and information display in our projects. Let’s dive into this exciting journey and bring our characters to life on the LCD screen

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Jumper Wires

	BUY



	I2C LCD1602

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	Usage Description





	IO21

	SDA



	IO22

	SCL






Schematic

[image: ../../_images/circuit_2.6_lcd.png]
Wiring

[image: ../../_images/2.6_i2clcd1602_bb.png]
Code


Note


	Open the 2.6_lcd1602.ino file under the path of esp32-starter-kit-main\c\codes\2.6_lcd1602.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?


	The LiquidCrystal I2C library is used here, you can install it from the Library Manager.


[image: ../../_images/lcd_lib.png]
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2.7 RGB LED Strip

In this project, we will delve into the mesmerizing world of driving WS2812 LED strips and bring a vibrant display of colors to life. With the ability to individually control each LED on the strip, we can create captivating lighting effects that will dazzle the senses.

Furthermore, we have included an exciting extension to this project, where we will explore the realm of randomness. By introducing random colors and implementing a flowing light effect, we can create a mesmerizing visual experience that captivates and enchants.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Jumper Wires

	BUY



	WS2812 RGB 8 LEDs Strip

	BUY






Schematic

[image: ../../_images/circuit_2.7_ws2812.png]
Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23







Note

IO33 is not available for this project.

The WS2812 LED strip is a type of LED strip that requires a precise pulse-width modulation (PWM) signal. The PWM signal has precise requirements in both time and voltage. For instance, a “0” bit for the WS2812 corresponds to a high-level pulse of about 0.4 microseconds, while a “1” bit corresponds to a high-level pulse of about 0.8 microseconds. This means the strip needs to receive high-frequency voltage changes.

However, with a 4.7K pull-up resistor and a 100nf pull-down capacitor on IO33, a simple low-pass filter is created. This type of circuit “smooths out” high-frequency signals, because the capacitor needs some time to charge and discharge when it receives voltage changes. Therefore, if the signal changes too quickly (i.e., is high-frequency), the capacitor will not be able to keep up. This results in the output signal becoming blurred and unrecognizable to the strip.



Wiring

[image: ../../_images/2.7_rgb_strip_bb.png]
Code


Note


	You can open the file 2.7_rgb_strip.ino under the path of esp32-starter-kit-main\c\codes\2.7_rgb_strip. Or copy this code into Arduino IDE.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?


	The Adafruit NeoPixel library is used here, you can install it from the Library Manager.


[image: ../../_images/rgb_strip_lib.png]
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3.1 Beep

This is a simple project to make an active buzzer beep quickly four times every second.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	Buzzer

	-



	Transistor

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_3.1_buzzer.png]
When the IO14 output is high, after the 1K current limiting resistor (to protect the transistor), the S8050 (NPN transistor) will conduct, so that the buzzer will sound.

The role of S8050 (NPN transistor) is to amplify the current and make the buzzer sound louder. In fact, you can also connect the buzzer directly to IO14, but you will find that the buzzer sound is smaller.

Wiring

Two types of buzzers are included in the kit.
We need to use active buzzer. Turn them around, the sealed back (not the exposed PCB) is the one we want.

[image: ../../_images/buzzer.png]
The buzzer needs to use a transistor when working, here we use S8050 (NPN Transistor).

[image: ../../_images/3.1_buzzer_bb.png]
Code


Note


	You can open the file 3.1_beep.ino under the path of esp32-starter-kit-main\c\codes\3.1_beep.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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3.2 Custom Tone

We have used active buzzer in the previous project, this time we will use passive buzzer.

Like the active buzzer, the passive buzzer also uses the phenomenon of electromagnetic induction to work. The difference is that a passive buzzer does not have oscillating source, so it will not beep if DC signals are used.
But this allows the passive buzzer to adjust its own oscillation frequency and can emit different notes such as “doh, re, mi, fa, sol, la, ti”.

Let the passive buzzer emit a melody!

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	Buzzer

	-



	Transistor

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_3.1_buzzer.png]
When the IO14 output is high, after the 1K current limiting resistor (to protect the transistor), the S8050 (NPN transistor) will conduct, so that the buzzer will sound.

The role of S8050 (NPN transistor) is to amplify the current and make the buzzer sound louder. In fact, you can also connect the buzzer directly to IO14, but you will find that the buzzer sound is smaller.

Wiring

Two types of buzzers are included in the kit.
We need to use passive buzzer. Turn them around, the exposed PCB is the one we want.

[image: ../../_images/buzzer.png]
The buzzer needs to use a transistor when working, here we use S8050 (NPN Transistor).

[image: ../../_images/3.1_buzzer_bb.png]
Code


Note


	Open the 3.2_custom_tone.ino file under the path of esp32-starter-kit-main\c\codes\3.2_custom_tone.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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4.1 Motor

In this engaging project, we’ll explore how to drive a motor using the L293D.

The L293D is a versatile integrated circuit (IC) commonly used for motor control in electronics and robotics projects. It can drive two motors in both forward and reverse directions, making it a popular choice for applications requiring precise motor control.

By the end of this captivating project, you will have gained a thorough understanding of how digital signals and PWM signals can effectively be utilized to control motors. This invaluable knowledge will prove to be a solid foundation for your future endeavors in robotics and mechatronics. Buckle up and get ready to dive into the exciting world of motor control with the L293D!

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	DC Motor

	BUY



	L293D

	-






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_4.1_motor_l293d.png]
Wiring


Note

Since the motor requires a relatively high current, it is necessary to first insert the battery and then slide the switch on the expansion board to the ON position to activate the battery supply.



[image: ../../_images/4.1_motor_l293d_bb.png]
Code


Note


	Open the 4.1_motor.ino file under the path of esp32-starter-kit-main\c\codes\4.1_motor.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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4.2 Pumping

In this intriguing project, we will delve into controlling a water pump using the L293D.

In the realm of water pump control, things are a bit simpler compared to controlling other motors. The beauty of this project lies in its simplicity - there’s no need to worry about the direction of rotation. Our primary goal is to successfully activate the water pump and keep it running.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Centrifugal Pump

	-



	L293D

	-






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_4.1_motor_l293d.png]
Wiring


Note

It is recommended here to insert the battery and then slide the switch on the expansion board to the ON position to activate the battery supply.



[image: ../../_images/4.2_pump_l293d_bb.png]
Code


Note


	You can open the file 4.2_pump.ino under the path of esp32-starter-kit-main\c\codes\4.2_pump.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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4.3 Swinging Servo

A Servo is a type of position-based device known for its ability to maintain specific angles and deliver precise rotation. This makes it highly desirable for control systems that demand consistent angle adjustments. It’s not surprising that Servos have found extensive use in high-end remote-controlled toys, from airplane models to submarine replicas and sophisticated remote-controlled robots.

In this intriguing adventure, we’ll challenge ourselves to manipulate the Servo in a unique way - by making it sway! This project offers a brilliant opportunity to dive deeper into the dynamics of Servos, sharpening your skills in precise control systems and offering a deeper understanding of their operation.

Are you ready to make the Servo dance to your tunes? Let’s embark on this exciting journey!

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Jumper Wires

	BUY



	Servo

	BUY






Available Pins

Here is a list of available pins on the ESP32 board for this project.







	Available Pins

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






Schematic

[image: ../../_images/circuit_4.3_servo.png]
Wiring


	Orange wire is signal and connected to IO25.


	Red wire is VCC and connected to 5V.


	Brown wire is GND and connected to GND.




[image: ../../_images/4.3_swinging_servo_bb.png]
Code


Note


	Open the 4.3_servo.ino file under the path of esp32-starter-kit-main\c\codes\4.3_servo. Or copy this code into Arduino IDE.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?


	The ESP32Servo library is used here, you can install it from the Library Manager.


[image: ../../_images/servo_lib.png]
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5.1 Reading Button Value

In this interactive project, we’ll venture into the realm of button controls and LED manipulation.

The concept is straightforward yet effective. We’ll be reading the state of a button. When the button is pressed down, it registers a high voltage level, or ‘high state’. This action will then trigger an LED to light up.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	LED

	BUY



	Button

	BUY






Available Pins


	Available Pins


Here is a list of available pins on the ESP32 board for this project.







	For Input

	IO14, IO25, I35, I34, I39, I36, IO18, IO19, IO21, IO22, IO23



	For Output

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23











	Conditional Usage Pins (Input)


The following pins have built-in pull-up or pull-down resistors, so external resistors are not required when using them as input pins:







	Conditional Usage Pins

	Description





	IO13, IO15, IO2, IO4

	Pulling up with a 47K resistor defaults the value to high.



	IO27, IO26, IO33

	Pulling up with a 4.7K resistor defaults the value to high.



	IO32

	Pulling down with a 1K resistor defaults the value to low.











	Strapping Pins (Input)


Strapping pins are a special set of pins that are used to determine specific boot modes during device startup
(i.e., power-on reset).







	Strapping Pins

	IO5, IO0, IO2, IO12, IO15






Generally, it is not recommended to use them as input pins. If you wish to use these pins, consider the potential impact on the booting process. For more details, please refer to the Strapping Pins section.








Schematic

[image: ../../_images/circuit_5.1_button.png]
To ensure proper functionality, connect one side of the button pin to 3.3V and the other side to IO14. When the button is pressed, IO14 will be set to high, causing the LED to light up. When the button is released, IO14 will return to its suspended state, which may be either high or low. To ensure a stable low level when the button is not pressed, IO14 should be connected to GND through a 10K pull-down resistor.

Wiring

[image: ../../_images/5.1_button_bb.png]

Note

A four-pin button is designed in an H shape. When the button is not pressed, the left and right pins are disconnected, and current cannot flow between them. However, when the button is pressed, the left and right pins are connected, creating a pathway for current to flow.



Code


Note


	You can open the file 5.1_button.ino under the path of esp32-starter-kit-main\c\codes\5.1_button.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?
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5.2 Tilt It！

The tilt switch is a simple yet effective 2-pin device that contains a metal ball in its center. When the switch is in an upright position, the two pins are electrically connected, allowing current to flow through. However, when the switch is tilted or tilted at a certain angle, the metal ball moves and breaks the electrical connection between the pins.

In this project, we will utilize the tilt switch to control the illumination of an LED. By positioning the switch in a way that triggers the tilt action, we can toggle the LED on and off based on the switch’s orientation.

Required Components

In this project, we need the following components.

It’s definitely convenient to buy a whole kit, here’s the link:








	Name

	ITEMS IN THIS KIT

	LINK





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






You can also buy them separately from the links below.







	COMPONENT INTRODUCTION

	PURCHASE LINK





	ESP32 WROOM 32E

	BUY    



	ESP32 Camera Extension

	-



	Breadboard

	BUY



	Jumper Wires

	BUY



	Resistor

	BUY



	LED

	BUY



	Tilt Switch

	-






Available Pins


	Available Pins


Here is a list of available pins on the ESP32 board for this project.







	For Input

	IO14, IO25, I35, I34, I39, I36, IO18, IO19, IO21, IO22, IO23



	For Output

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23











	Conditional Usage Pins (Input)


The following pins have built-in pull-up or pull-down resistors, so external resistors are not required when using them as input pins:







	Conditional Usage Pins

	Description





	IO13, IO15, IO2, IO4

	Pulling up with a 47K resistor defaults the value to high.



	IO27, IO26, IO33

	Pulling up with a 4.7K resistor defaults the value to high.



	IO32

	Pulling down with a 1K resistor defaults the value to low.











	Strapping Pins (Input)


Strapping pins are a special set of pins that are used to determine specific boot modes during device startup
(i.e., power-on reset).







	Strapping Pins

	IO5, IO0, IO2, IO12, IO15






Generally, it is not recommended to use them as input pins. If you wish to use these pins, consider the potential impact on the booting process. For more details, please refer to the Strapping Pins section.








Schematic

[image: ../../_images/circuit_5.2_tilt.png]
When the tilt switch is in an upright position, IO14 will be set to high, resulting in the LED being lit. Conversely, when the tilt switch is tilted, IO14 will be set to low, causing the LED to turn off.

The purpose of the 10K resistor is to maintain a stable low state for IO14 when the tilt switch is in a tilted position.

Wiring

[image: ../../_images/5.2_tilt_switch_bb.png]
Code


Note


	You can open the file 5.2_tilt_switch.ino under the path of esp32-starter-kit-main\c\codes\5.2_tilt_switch.


	After selecting the board (ESP32 Dev Module) and the appropriate port, click the Upload button.


	Always displaying “Unknown COMxx”?







  
    
    

    5.3 D